Produced by Psion Technical Support
Psion Digital Contacts: www.psion.com/international
Limited Knowledgebase: www.psion.com/support

Synchronizing your Psion with
Microsoft Outlook

Note: All occurrences of Revo in this document also refer to Revo Plus unless otherwise specified.
This document details the set-up and day-to-day use of PsiWin 2.3 to synchronize your Psion Series
3a, 3¢, 3mx, 5, Smx, 7, Siena or Revo Agenda and Data files or Contacts program (5mx/7/Revo) with
Microsoft Outlook 97 or 98 on the PC. The document does assume some basic familiarity with the use
of Windows 95, 98 or NT 4.0.

Software compatibility

The details for this document assume that you are using version 2.3 of PsiWin. To check which
version of PsiWin you have, double-click the My Psion icon on your desktop, and select About
PsiWin 2.x from the Help menu. If you have at least Build 136 then you have version 2.3. If you have
a previous version of PsiWin 2.x, you will find a section on earlier versions towards the end of this
document.

You must also have a full local installation of Microsoft Outlook 97 or 98.

Creating new synchronizations

You can create multiple synchronizations on your PC should you have different Agenda or Data files,
or Outlook folders that you wish to synchronize. See the section on creating multiple synchronizations
towards the end of this document. You will need to define at least one synchronization.

Required information

Before creating your synchronization, you will need to note the locations of the files you wish to

synchronize.

1. From the Series 3a, 3c, 3mx, 5 or Siena you may synchronize your Agenda or Data files, while
from the Series Smx, 7 or Revo you may also synchronize with the Contacts program. If you are
synchronizing an Agenda or Data file from a Series 5, Smx, 7 or Revo, open the files

you wish to synchronize. October 1 = — Agenda
Open files /
Tap the filename at the top Pt Joe L pIRg S
fthe toolbar and vou will

0 ¢ toolbar a.n you wi Sun Sheet c:\WorkiExample

see the Open files / 12 Sketch c:i\DocumentsiPics

programs dialog. Scroll . System Cut+E

through the list until you 13 %
. i sC

find your file(s) hsFed. Make .

a note of the path (in this 14 Enter

example, c:\Work\Agenda).
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2.

If you have a Series 3a, 3¢, 3mx + DiskInternal, 467K free + S
or Siena, highlight the file(s) that SAGNN= Me
you wish to synchronize and A “AGN
press Tab. The top line of this Wa iRTE]
dialog will tell you on which NIS

Disk the file is stored, in this by
example, Internal. [14th]

The fourth line tells you the path to the file (in this example, \AGN\) and the highlighted line tells
you the filename (in this example, Agenda.agn). So, the location of the file will be:

[Disk]:[Path to file][Filename], in this example, M:\AGN\Agenda.agn. Press Esc to remove
this dialog. Note that if the file is on the Internal disk then [Disk] will be M. If it is on the A or B
disks then [Disk] will be A or B.

Creating the synchronization

1. Make sure that your Psion is connected to the PC, then double-click on the My %‘;@
Psion icon. Assuming the machines have linked successfully, you will see several >
icons, including one labelled Psion Synchronizer. Double-click on this icon. Syn':;s':'r’;‘ni
In the Psion Synchronizer window, B, Psion Synchranizer mE 5
click the New button. This will launch _
the Psion Synchronizer Wizard, which !QI.%
will take you through the steps required )
to set up the synchronization. If you Synchronize
have never cr.eatefl a synchroglzat}on Avtomalio. |
before, PsiWin will bypass this window
and go straight to the Synchronization Mew || Delete Propetties... Hop | Cese |
Wizard.

2. The welcome page of the Wizard asks you the PC Lotus Oiganizer 21

. . . ofus Urgarnizer
Personal Information Manager (PIM) with which Lot Oraanizer 37 G5
. . . . b icrosoft Outlook,
you wish to synchronize. Highlight the relevant Micrasolt Schedule+ 7.0/ 7.0a
option and click the Next button.
< Back Cancel | Help |
|
3. On the Applications page, you will need to enter
. . Use the suggested file[z], which Pziwin can create for pou if
the path(S) for the ﬁle(S) you wish to SynChI'OIllZC. necesszary, of browse for existing files which contain your
. . . . infarmation. *Y'ou may alzo need to enter your Dutlack datails.

In the Psion section, you will need to specify the - Psion

. . . . . W Synchronize My Agenda
Psion files with which you wish to synchronize. If [ o agerd B

. . (=N arl Jenda
you wish to S}inchromze an Agenda} ﬁ!e, ensure that % Sunchrorize My Cortacts
the Synchronize My Agenda box is ticked. You . [Eantacts program L]
will then need to specify the Agenda file to be YT
synchronized. You can either type in the path and Calongar Folder |Prsonal FoldersiCalendar\Example
filename you noted earlier or click the _- button to I Use Default Calendar Folder
browse the Psion’s disks. If in doubt, use the browse Tk Folder |
button to ﬁnd your file. V! Use Default Task Folder
If you wish to synchronize a Data file or the comoctsFader |
ontacks Folder
Contacts program (5mx/7/Revo), ensure that the [ Use Default Cartacts Folder
Synchronize My Contacts box is ticked. The next Erchangs Setings... |
step depends on whether you are synchronizing with
a.Serles Smx, 7 or Revo or a Series 3a, 3¢, 3mx, 5 or e [ Hen | cenesl | e |
Siena.
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e Series 3a, 3¢, 3mx, 5 or Siena

Next, you need to specify the Data file to be synchronized. You can either type in the path
and filename you noted earlier or click the _-| button to browse the Psion’s disk(s). If in doubt,

use the browse button to find your file.

e Series 5mx, 7 or Revo
If you wish to synchronize with the Contacts program,

you should leave the next box as Contacts program. If

you wish to synchronize with a Data file, click the -
button. Next, select Data and specify the Data file to
be synchronized. You can either type in the path and
filename you noted earlier or click the _- button to
browse the Psion’s disk(s). If in doubt, use the browse
button to find your file. Next, click the OK button.

4. Next, you need to enter details for Microsoft Outlook. If

you wish to synchronize the standard Outlook folders
then leave all the Use Default... boxes ticked. If you
wish to synchronize custom Outlook folders, you will

Choose contacts program m

Select the Psion programm you wizh to uze far this
contacts synchronization

" Cortacts program

% Data
File: |c:\DocumentstJutlook, Contacts _I
Cancel |
Folder List b4 |
- @' Outlook Today - [Personal Folderz]
--¢% Calendar
% Example

need to untick the relevant Use Default... box and enter
the folder path. You can find the folder path by looking
at the Folder List in Outlook. If you do not have this
shown, select Folder List from the View menu. Expand
the list until you can see the folder you wish to
synchronize. The path will be: the top level folder, then
the subfolder that contains the folder(s) to synchronize,
then the folder to synchronize. These should be
separated by backslashes (\). If the name of your top
level folder contains some text in square brackets, use

r Microsoft Outlook,

|Personal FaldershCalendarE sample

[T Use Default Calendar Folder

Calendar Folder:

Taszk Folder: I
¥ Use Default Task Folder

Contactz Folder. I
¥ Use Default Contacts Folder

Exchange Settings.. |

this text instead of the top level folder name. In the example shown here, the path to the Example
folder is Personal Folders\Calendar\Example. You should then enter this information into the
Applications dialog of the Synchronization wizard. Untick the relevant Use Default... box, in
this example, Use Default Calendar Folder, and type the path into the box (in this example the
Calendar Folder box).

Once this information has been entered, click on the Next button. Note that it is very important
that this information is entered correctly — if it is not, the wrong files may be synchronized, or no
synchronization will occur. However, if you do not have an existing Agenda or Database file on
your Psion, the synchronizer can create them. This is especially useful for a Contacts database - if
you specify a non-existent Psion Data file, the synchronizer will create a new one on the Psion
that is optimised for use with your Outlook contacts. If you are synchronizing with a Series Smx,
7 or Revo, the synchronization can only create a Data file if you have selected the option to
synchronize a Data file.

5. Click on the Exchange Settings... button, enter a profile
name and click the OK button if you wish to
synchronize with an Outlook profile other than your
PC’s default.

Exchange Settings n

Select a Profile from the list below. If the profile you wish to use iz
not present then type it inta the box,

Chrig
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6. The next page allows you to specify which types of

entry you wish to synchronize. You can untick

Select the entry types to be synchronized between pour Pgion and

particular entry types if you do not want them to be PC Agendas.
synchronized.

Click the Next button when you have selected the [ Entty pes to synchionize
entry types.

W snniverzaries / Annual Events

[V Events

¥ To-dos / Tasks

< Back I Hext » I Cancel | Help |

7. To specify the period of entries you wish to

synchronize, click the Set date range button, select
the period required and click the OK button.

r Senchronize Agenda entrie:
From: 1 Month(z] in the past.

To specify how the synchronization will deal with Ta: & Month(s) in the future.
entries outside of normal working hours, select the ~Agends entis to synchronize

X ) > - L
appropriate option from the Agenda entries to All specified enties

. . o Al specified entries, but make entrigs outside work hours

synchronize section. You can also change your piivate on the FC
work hours by clicking the Set work hours button, € Oy entries within your work hours
altering the settings as appropriate and clicking the
OK button Days: Mon Tue Wed Thu Fri

Hows:  9:00am-5:30pm Set work haurs

Next, click on the Advanced button to set up the
label mapping. Note that if you are synchronizing

r Contacts details to synchronize

The Synchranizer will prompt pou if vou need ta change any

with the Contacts program, or have chosen not to contact spnchianization settings.
1 1 Click Advanced to check the cunent
sypchromze a De.lta file, you may noF be able to click e e P—
this button. In this case, you should ignore step 8 4|‘
below and click the Next button.
¢ Back Mewt = Cancel | Help |
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8. The Contacts Synchronization page shows a table,
listing the labels for the Contacts folder in Outlook
(or whichever folder you have specified for contacts
information) in the Contact information column,
and in the Psion label column you can match these
to their equivalents (if any) in your Psion Data file.

E% Contacts Synchronization

x|

The ligt below shows the Qutlook figlds which you can synchionize with
wour Pzion address book, and the Pzion labels with which they will be

synchronized.

IF you want to synchronize a Outlook field with a different Pgion label
from that which iz displayed, click in the Psion label box nest to the
appropriate Outlook field and select from the available Psion labels.

To match labels:
. . . . Contact information | F'zion label | -
i.  Find the Outlook label whose function is the Name, last Last Name:
. 5 Mame, first First Mame:
same as one of your Psion Data file’s labels, Mame, midde
. . e . Compary Compary:
then click in the box next to it in the Psion label Departmert
Column Job Litle Job Title:
: Business address i
ii. An arrow =l will appear to the right of this box. pushess il Iprovinge (anore, =
If you click on this, a drop-down list will gzz::gzzf‘;ﬁ;“a' cade ork Tel (2] -
appear, containing all the Psion labels that you Home adres o P
. arne ciky : *
have not matched. Select the label you wish to = ; Fager M
assign. E rail: -
iii. If you do not wish to synchronize with a oK Cancel || Hep |

particular Outlook label, you should select
<Ignore> from the drop-down list

Note that each Psion label can only be matched to one Outlook label.
9. When you have finished matching the labels, click the OK button and then the Next button.

10. The last page of the wizard is simply a confirmation screen. If you wish to start the
synchronization process immediately, click on the Synchronize Now button, otherwise click on
the Finish button to complete the set-up and save the synchronization.

If this is the first time you have run the synchronization, you may see the Contacts
Synchronization dialog described in Step 8 above. If there are any labels on the Psion that cannot
be directly mapped, the synchronization will prompt you to do this by hand.

Using an existing synchronization

Once you have set up the synchronization as above, you can use it whenever you wish. To run an
individual synchronization:

1. Connect your Psion and PC.

2. Double-click on the My Psion icon, and then double-click on the Psion synchronizer icon.
3. Click on the icon for the desired synchronization(s) so that they are highlighted.
4. Click on the Synchronize button.

Synchronizing with older versions of PsiWin 2

You can still synchronize with older versions of PsiWin 2. All versions older than 2.2 will only let
you synchronize with a Series 5 and require that the files to be synchronized are closed. To do this,
highlight the file(s) on the system screen of the Psion and press Ctrl + E. Also, ensure that Outlook is
closed on the PC. Versions 2.0 and 2.01 do not work with Microsoft Outlook. Version 2.1 will not
work with Outlook 98. The user interface of previous versions will look slightly different from the
dialogs shown here, but all the information required is the same. Note that PsiWin 2.3 must be used to
synchronize with a Series Smx, 7 or Revo.
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Multiple Synchronizations

It is possible to synchronize multiple Agenda and Data files or
Outlook folders. To do this you will need to set up multiple
synchronizations. To do this you may need to create extra
Outlook folders. You can do this by selecting New, then
Folder... from the File menu. Type in a name for the new
folder, select the type of items to be stored in the folder (in this
example, Contact Items), select the folder to create the new
folder in and click the OK button.

When you create the synchronization, enter the appropriate
paths and filenames in the applications dialog.

Create New Folder nm
Marne:
2 [ > |
Folder contains: Cancel |
IContact Ttems LI

Make this folder a subfolder of:

=-173 Personal Folders -~
% Calendar
= @ Contacts
2 Business
42 Personal
=

@ Deleted Items
&2 Inbox

(ﬁ Journal
Notes

@ Outbox

IF Sent llems

Description:

[ Create a shortcut to this Folder in the Qutlook Bar

Applications

Use the suggested Psian filels), which Psiwin can create for
vou it neceszary, or browse for exizting files which contain your
information. *r'ou may also need ta enter your Outlook details,

r Psion
[ Synchronize My Agenda

¥ Synchionize My Contacts
@ |c \Documents\Extra . |

r Microzoft Outlock.

Calendar Falder: I
¥ Use Defaul Calendar Folder

Task Folder: I
[¥] Use Defaul Task Folder

IPemna\ Folders\Cantacts\Extra

[T Use Default Contacts Foldsr

Contacts Falder:

Exchange Settings.. I

< Back, I Mewt > I Cancel | Help |

Note: You should never synchronize multiple Psion files with a single Outlook folder or multiple
Outlook folders with a single Psion file as this will result in the multiple files being mixed together.
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